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Chapter 369

Mixed Models Tests for
Interaction in a 2×2
Factorial 2-Level
Hierarchical Design
(Level-1 Randomization)
Introduction
This procedure calculates power and sample size for a two-level hierarchical mixed model in which clusters of
subjects are measured one time (cross-sectional) on a continuous variable. The study uses a two-by-two factorial
design with two binary factors, each with two possible values (0 and 1). This results in four treatment arms. The
goal of the study is to test the significance of the two-way interaction between the two factors.
In this two-level hierarchical design, the subjects are the level-one units and the clusters are the level-two units.
Each subject is individually randomized to receive one of the four possible treatments. Hence, all four treatments
occur within each level-2 unit.

Technical Details
Our formulation comes from Ahn, Heo, and Zhang (2015), chapter 5, section 5.5.2, pages 170-172. The
hierarchical mixed model that is adopted is
𝑌𝑌𝑖𝑖𝑖𝑖 = 𝛽𝛽0 + 𝛿𝛿𝑋𝑋(1) 𝑋𝑋𝑖𝑖𝑖𝑖 + 𝛿𝛿𝑍𝑍(1) 𝑍𝑍𝑖𝑖𝑖𝑖 + 𝛿𝛿𝑋𝑋𝑋𝑋(1) 𝑋𝑋𝑖𝑖𝑖𝑖 𝑍𝑍𝑖𝑖𝑖𝑖 + 𝑢𝑢𝑖𝑖 + 𝑒𝑒𝑖𝑖𝑖𝑖

where
𝑌𝑌𝑖𝑖𝑖𝑖

is the continuous response of the jth subject in the ith cluster.

𝛿𝛿𝑋𝑋(1)

is the treatment effect of X.

𝛿𝛿𝑍𝑍(1)

is the treatment effect of Z.

𝛽𝛽0

𝑋𝑋𝑖𝑖𝑖𝑖

is the fixed intercept.

is an indicator variable that is = 1 if cluster i is assigned to receive the X intervention and 0
otherwise.
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𝑍𝑍𝑖𝑖𝑖𝑖

is an indicator variable that is = 1 if cluster i is assigned to receive the Z intervention and 0
otherwise.

𝑢𝑢𝑖𝑖

is a random effect term for the ith cluster the is distributed as 𝑁𝑁(0, 𝜎𝜎𝑢𝑢2 ).

𝛿𝛿𝑋𝑋𝑋𝑋(1) is the interaction effect of X and Z. In terms of the four group means, this effect is equal to
(𝜇𝜇1,1 − 𝜇𝜇1,0 ) − (𝜇𝜇0,1 − 𝜇𝜇0,0 ).

𝑒𝑒𝑖𝑖𝑖𝑖

is a random effect for the jth subject in the ith cluster that is distributed as 𝑁𝑁(0, 𝜎𝜎𝑒𝑒2 ).

𝜎𝜎𝑒𝑒2

is variance of the level one (subject) random effects.

𝜌𝜌

is the intraclass correlation (ICC). This is the correlation between any two level-1 units within a
specific level-2 unit.

𝜎𝜎𝑢𝑢2

𝜎𝜎 2

is variance of the level(cluster) random effects.
is the variance of Y, where 𝜎𝜎 2 = 𝜎𝜎𝑢𝑢2 + 𝜎𝜎𝑒𝑒2 .

𝐾𝐾

is the number of level-2 units in the study.

𝑀𝑀0,1

is the number of level-1 units per level-2 unit for which X = 0 and Z = 1.

𝑀𝑀0,0

is the number of level-1 units per level-2 unit for which X = 0 and Z = 0.

𝑀𝑀1,0

is the number of level-1 units per level-2 unit for which X = 1 and Z = 0.

𝑀𝑀1,1

is the number of level-1 units per level-2 unit for which X = 1 and Z = 1.

The test of significance of the product XijZij term in the mixed model analysis is the test statistic of interest. It tests
whether the difference between the two levels of one factor at the high level of the other factor is equal to the
corresponding difference at the low level of the second factor.
Assume that 𝛿𝛿𝑋𝑋𝑋𝑋(1) is to be tested using a Wald test. The statistical hypotheses are 𝐻𝐻0 : 𝛿𝛿𝑋𝑋𝑋𝑋(2) = 0 vs. 𝐻𝐻𝑎𝑎 : 𝛿𝛿𝑋𝑋𝑋𝑋(2) ≠
0.

The power is calculated using

where 𝑓𝑓 = 1 − 𝜌𝜌.

⎧
⎫
⎪𝛿𝛿𝑋𝑋𝑍𝑍(2)
⎪
𝐾𝐾
− Φ(1 − 𝛼𝛼/2)
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 = Φ
⎨ 𝜎𝜎 �𝑓𝑓 � 1 + 1 + 1 + 1 �
⎬
⎪
⎪
𝑀𝑀0,0 𝑀𝑀1,1 𝑀𝑀1,0 𝑀𝑀0,1
⎩
⎭
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are δ (Interaction), Power, K, and M00.
Under most situations, you will select either Power to calculate power or K00 to calculate the number of level-2
units. Occasionally, you may want to fix the number of level-2 units and find the necessary average number of
level-1 units.
Note that the value selected here always appears as the vertical axis on the charts.
The program is set up to calculate power directly. To find appropriate values of the other parameters, a binary
search is made using an iterative procedure until an appropriate value is found. This search considers integer
values of K00 and M only.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
If your only interest is in determining the appropriate sample size for a confidence interval, set power to 0.5.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Usually, the value of 0.05 is used for alpha and this has become a standard.
This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha
that represents the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
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Sample Size – Number of Level-1 and Level-2 Units
K (Level-2 Unit Count)
This is the number of level-2 units (e.g., classes) in the study. This value must be a positive integer that is at least
1.
List
You can use a list of values such as "8 12 16". A separate analysis will be run for each element in the list.
M00 (Group 00 Count (X=0, Z=0))
This is the number of level-1 units (e.g., subjects) per level 2 unit in group 00, which we have designated as the
group in which both of the binary factors X and Z are zero (i.e., control group). The total sample size (number of
level-1 units) of this group is equal to K × M00.
Each of the factors X and Z have two levels: 0 (no intervention) and 1 (intervention). Thus, in this group in which
X = 0 and Z = 0, neither of the interventions occur. Hence, this is called the control group.
This value must be a positive integer.
List
You can enter a list of values such as "10 20 30". A separate analysis will be run for each element in the list.
M01 (Group 01 Count (X=0, Z=1))
This is the number of level-1 units (e.g., classes) per level 2 unit in group 01, which we have designated as the
group in which X is zero and Z is one (i.e., only factor two is active). The total sample size (number of level-1
units) for this group is K × M01.
Each of the factors X and Z have two levels: 0 (no intervention) and 1 (intervention). Thus, in this group in which
X = 0 and Z = 1, an intervention occurs for the second factor but not the first.
Using Multiples of M00
If you simply want a multiple of the value for group 00, enter the multiple followed by "M00", with no blanks. If
you want to use M00 directly, you do not have to enter a leading "1". For example, all of the following are valid
entries: M00 10M00 2M00 0.5M00.
List
You can use a list of values such as "10 20 30" or "M00 2M00 3M00".
M10 (Group 01 Count (X=1, Z=0))
This is the number of level-1 units (e.g., classes) per level 2 unit in group 10, which we have designated as the
group in which X is one and Z is zero (i.e., only factor one is active). The total sample size (number of level-1
units) for this group is K × M10.
Each of the factors X and Z have two levels: 0 (no intervention) and 1 (intervention). Thus, in this group in which
X = 1 and Z = 0, an intervention occurs for the first factor but not the second.
Using Multiples of M00
If you simply want a multiple of the value for group 00, enter the multiple followed by "M00", with no blanks. If
you want to use M00 directly, you do not have to enter a leading "1". For example, all of the following are valid
entries: M00 10M00 2M00 0.5M00.
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List
You can use a list of values such as "10 20 30" or "M00 2M00 3M00".
M11 (Group 11 Count (X=1, Z=1))
This is the number of level-1 units (e.g., classes) per level 2 unit in group 11, which we have designated as the
group in which X is one and Z is one (i.e., both factors are active). The total sample size (number of level-1 units)
for this group is K × M11.
Each of the factors X and Z have two levels: 0 (no intervention) and 1 (intervention). Thus, in this group in which
X = 1 and Z = 1, an intervention occurs for both factors.
Using Multiples of M00
If you simply want a multiple of the value for group 00, enter the multiple followed by "M00", with no blanks. If
you want to use M00 directly, you do not have to enter a leading "1". For example, all of the following are valid
entries: M00 10M00 2M00 0.5M00.
List
You can use a list of values such as "10 20 30" or "M00 2M00 3M00".

Effect Size
δ (Interaction = (μ11 - μ10) - (μ01 - μ00))
Enter a value for the interaction among the four group means at which the study is to be powered. That is, the
power is the probability of detecting a difference of at least this amount. This value is not necessarily the true
interaction difference. Rather, it is the interaction difference that you want to be able to detect.
Interaction
The interaction is the difference of the differences. That is, it is constructed as the difference between the two
differences (μ11 - μ10) and (μ01 - μ00). It is the failure of the two factors to act independently of each other.
δ can be any non-zero value (positive or negative). Since this procedure uses a two-sided test statistic, you will get
the same result with either positive or negative values.
Syntax
You can enter a single value such as 10 or a series of values such as 10 20 30 or 5 to 50 by 5. When a series of
values is entered, PASS will generate a separate calculation result for each value of the series.
σ (Standard Deviation)
Enter the subject-to-subject standard deviation. This standard deviation applies for all groups.
Note that σ must be a positive number. You can enter a single value such as 5 or a series of values such as 1 3 5 7
9 or 1 to 9 by 2. Press the small ‘σ’ button to the right to obtain calculation options for estimating the standard
deviation.
ρ (Intraclass Correlation, ICC)
This is the value of the intraclass (or intracluster) correlation coefficient. It may be interpreted as the correlation
between any two level-1 observations from the same level-2 unit.
Possible values are from 0 to just below 1. Typical values are between 0.0001 and 0.5. You may enter a single
value or a list of values.
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Example 1 – Calculating Power
Suppose that a two-level hierarchical design is planned in which there will be two interventions. Each intervention
will be whether one of two drugs is administered. There will be only one measurement per subject and each
subject (level-1 unit) will be randomized to a group individually. The analysis will be a mixed model of
continuous data using the model given earlier in this chapter. The following parameter settings are to be used for
the power analysis: δ = 7; σ = 9.7; ρ = 0.06; K = 4 or 6; α = 0.05; and M00 = M01 = M10 = M11 = 5 to 20 by 5.
Find the power of each combination of parameter settings.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mixed Models Tests for Interaction in a 2×2 Fact. 2-Level Hier. Design (Level-1 Rand.)
procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to
the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ....................................................... Power
Alpha .............................................................. 0.05
K (Level-2 Unit Count) ................................... 4 6
M00 (Group 00 Count (X=0, Z=0)) ................ 5 10 15 20
M01 (Group 01 Count (X=0, Z=1)) ................ M00
M10 (Group 10 Count (X=1, Z=0)) ................ M00
M11 (Group 11 Count (X=1, Z=1)) ................ M00
δ (Interaction = (μ11 - μ10) - (μ01 - μ00)) ..... 7
σ (Standard Deviation) .................................. 9.7
ρ (Intraclass Correlation, ICC) ....................... 0.06

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for an Interaction in a 2×2 Factorial ────────────────────────────────────

Power
0.3838
0.6531
0.8219
0.9145
0.5313
0.8219
0.9419
0.9829

Total
Level 1
Count
N
80
160
240
320
120
240
360
480

Level 2
Count
K
4
4
4
4
6
6
6
6

Grp(0,0) Grp(0,1) Grp(1,0) Grp(1,1)
Level 1 Level 1 Level 1 Level 1
Count
Count
Count
Count
M00
M01
M10
M11
5
5
5
5
10
10
10
10
15
15
15
15
20
20
20
20
5
5
5
5
10
10
10
10
15
15
15
15
20
20
20
20

Inter
Diff
δ
7.00
7.00
7.00
7.00
7.00
7.00
7.00
7.00

Std
Dev
σ
9.70
9.70
9.70
9.70
9.70
9.70
9.70
9.70

ICC
ρ
0.060
0.060
0.060
0.060
0.060
0.060
0.060
0.060

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050

References
Ahn, C., Heo, M., and Zhang, S. 2015. Sample Size Calculations for Clustered and Longitudinal Outcomes in
Clinical Research. CRC Press. New York.
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Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
N is the total number of level-1 units in the study.
K is the number of level-2 units in the study.
M00 (Group 00 Count (F1=0, F2=0)) is the number of level-1 units per level-2 unit in Group 00 (F1 = 0 and F2 = 0).
M01 (Group 01 Count (F1=0, F2=1)) is the number of level-1 units per level-2 unit in Group 01 (F1 = 0 and F2 = 1).
M10 (Group 10 Count (F1=1, F2=0)) is the number of level-1 units per level-2 unit in Group 10 (F1 = 1 and F2 = 0).
M11 (Group 11 Count (F1=1, F2=1)) is the number of level-1 units per level-2 unit in Group 11 (F1 = 1 and F2 = 1).
δ is the interaction difference (μ11 - μ10) - (μ01 - μ00) at which the power is calculated.
σ is the standard deviation of the subject responses.
ρ (ICC) is the intraclass correlation among level-1 units within a single level-2 unit.
Alpha is the probability of rejecting a true null hypothesis, that is, rejecting when the means are actually equal.
Summary Statements ─────────────────────────────────────────────────────────
A total sample size of 80 level-1 units were obtained by sampling 4 level-2 units and then,
from each level-2 unit, sampling 5 level-1 units in group 00, 5 level-1 units in group 01, 5
level-1 units in group 10, and 5 level-1 units in group 11. This sample achieves 38% power to
detect an interaction difference among the group means of at least 7.00. This interaction
difference was formed from the four group means using the following formula: δ = (μ11 - μ10) (μ01 - μ00). The standard deviation of subjects is 9.70. The intraclass correlation coefficient
is 0.060. A test based on a mixed-model analysis is anticipated at a significance level of
0.050.

This report shows the power for each of the scenarios.

Plots Section

These plots show the power for the various parameter settings.
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Example 2 – Calculating Sample Size (M00)
Continuing with the last example, suppose the researchers want to determine the value of M00 needed to achieve
90% power for both values of K.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mixed Models Tests for Interaction in a 2×2 Fact. 2-Level Hier. Design (Level-1 Rand.)
procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to
the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ....................................................... M00 (Group 00 Count of Level-1 Units)
Power ............................................................. 0.90
Alpha .............................................................. 0.05
K (Level-2 Unit Count) ................................... 4 6
M01 (Group 01 Count (X=0, Z=1)) ................ M00
M10 (Group 10 Count (X=1, Z=0)) ................ M00
M11 (Group 11 Count (X=1, Z=1)) ................ M00
δ (Interaction = (μ11 - μ10) - (μ01 - μ00)) ..... 7
σ (Standard Deviation) .................................. 9.7
ρ (Intraclass Correlation, ICC) ....................... 0.06

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for an Interaction in a 2×2 Factorial ────────────────────────────────────

Power
0.9005
0.9077

Total
Level 1
Count
N
304
312

Level 2
Count
K
4
6

Grp(0,0) Grp(0,1) Grp(1,0) Grp(1,1)
Level 1 Level 1 Level 1 Level 1
Count
Count
Count
Count
M00
M01
M10
M11
19
19
19
19
13
13
13
13

Inter
Diff
δ
7.00
7.00

Std
Dev
σ
9.70
9.70

ICC
ρ
0.060
0.060

Alpha
0.050
0.050

This report shows the power for each of the scenarios.
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Example 3 – Validation using Ahn, Heo, and Zhang (2015)
Ahn, Heo, and Zhang (2015) page 173 provide a table in which several scenarios are reported. We will validate
this procedure by duplicating the top entry. The following parameter settings are used for the power analysis:
Power = 0.80; δ = 0.4; σ = 1; ρ = 0.1; M00, M01, M10, M11 are 10; and α = 0.05. The value of K is found to be
18 and the attained power at 0.807.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mixed Models Tests for Interaction in a 2×2 Fact. 2-Level Hier. Design (Level-1 Rand.)
procedure window. You may then make the appropriate entries as listed below, or open Example 3 by going to
the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ....................................................... K (Level-2 Unit Count)
Power ............................................................. 0.80
Alpha .............................................................. 0.05
M00 (Group 00 Count (X=0, Z=0)) ................ 10
M01 (Group 01 Count (X=0, Z=1)) ................ M00
M10 (Group 10 Count (X=1, Z=0)) ................ M00
M11 (Group 11 Count (X=1, Z=1)) ................ M00
δ (Interaction = (μ11 - μ10) - (μ01 - μ00)) ..... 0.4
σ (Standard Deviation) .................................. 1
ρ (Intraclass Correlation, ICC) ....................... 0.1

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for an Interaction in a 2×2 Factorial ────────────────────────────────────

Power
0.8074

Total
Level 1
Count
N
720

Level 2
Count
K
18

Grp(0,0) Grp(0,1) Grp(1,0) Grp(1,1)
Level 1 Level 1 Level 1 Level 1
Count
Count
Count
Count
M00
M01
M10
M11
10
10
10
10

Inter
Diff
δ
0.40

Std
Dev
σ
1.00

ICC
ρ
0.100

Alpha
0.050

PASS also calculates the value of K to be 18 and the power at 0.8074.
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